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1 Introduction

DropDMG is a utility for creating disk images in Mac OS X’s device image (DMG) format.
Disk images are a wonderful way of packing entire folders or disks into a single file, either for
transport across the Internet or simply for achival. They are typically created using Apple’s
Disk Copy utility, and Disk Copy can also “mount” an image—make its contents accessible
as if they resided on an inserted CD-ROM.

Although Disk Copy is a standard component of Mac OS X, it makes simple tasks more
time consuming than they should be. To create a compressed image from a folder using
Disk Copy, you must create a blank read-write image of the appropriate size (specifying
the volume name and location for the saved file), manually copy the folder to the image,
unmount the image, convert the image to a compressed format, and finally delete the original
(uncompressed) image. With DropDMG, you simply drag and drop the folder onto the
DropDMG icon®.

Documents DropDMG Documents.dmg

Here’s a brief rundown of DropDMG's features:

e Quick and easy creation of compressed disk images. Just drag and drop a folder onto
the DropDMG application’s icon.

'Really. There aren’t any dialog boxes; it’s even easier than in Mac OS 9.



e Create DMGs in the zlib- and ADC-compressed formats, as well as Mac OS 9’s read-
only compressed NDIF (.img) format.

e Make encrypted compressed disk images.

e Reliability. Like all good Mac applications?, DropDMG has no trouble handling folders
with spaces, quotation marks, dollar signs, or other “special” characters.

o GZip images for further compression and increased compatibility with Web servers.
e Fix downloaded DMGs so that they open in Disk Copy.
e Package-savvy.

e (Clean and simple interface that stays out of your way and respects your screen real
estate.

e Create images using AppleScript.
e Runs natively on Mac OS X.

e Does not require Mac OS X’s optional “BSD Subsystem” installation.

2 Installation

DropDMG has been developed and tested on Mac OS X 10.1.3. I do not have the resources
to test it on older systems, although I suspect it will work fine on Mac OS X 10.1 or later.
DropDMG does not require Mac OS X’s optional “BSD Subsystem” installation.

Double-click the DropDMG-1.3.dmg file to mount the image with Disk Copy. If you like,
you can run DropDMG directly from the image to test it out. To install, simply copy the
application to your hard disk, e.g. into /Applications/Utilities.

There’s no need to copy this manual to your hard disk. A copy of it is built-into
DropDMG, and you can access it by choosing DropDMG Help from the Help menu.

3 Using DropDMG

3.1 Making Disk Images

There are several ways to create disk images using DropDMG. All of them use the current
preferences to determine the image format and whether to use encryption.

Drag and Drop Drag and drop one or more folders onto the DropDMG icon, either in the
Finder or in the Dock.

Menu Choose Make Image From Folder... from the File menu.

2But, sadly, unlike many quick-and-dirty utilities and shell scripts.



AppleScript

tell application "Finder"
-- ask the user
set myFolder to choose folder

-- or use a path
set myFolder to alias "HD:Users:me:folder:"
end tell
tell application "DropDMG"
-- create an image using the options in the preferences
open myFolder

-- or specify the options with AppleScript
create image from folder myFolder destination "/Users/me/folder"
format ADC compressed with encryption and gzip
end tell

Command-Line To create disk images using the options specified in the preferences, you
can use open® and pass the folders as arguments:

open -a DropDMG.app ~/path/to/a/folder ~/another/folder

If you want to specify options from the command line, use osascript -e to run an
AppleScript, as above.

3.2 Fixing Disk Images

Sometimes a downloaded disk image won’t open in Disk Copy because the Web server told
the Web browser that the disk image was a text file. DropDMG can fix such images by
setting their type and creator codes so that the Finder will open them in Disk Copy. There
are several ways to fix disk images:

e Drag and drop one or more disk images onto the DropDMG icon, either in the Finder
or in the Dock.

e Choose Fix Disk Image... from the File menu.

e Use open with AppleScript or the command line, as above.

3Note that open will return before DropDMG has finished creating the image, so if you are writing a
shell script that will act on the finished image file it’s best to use osascript and DropDMG’s AppleScript
interface, instead.



3.3 Setting the Preferences
3.3.1 Image Format

zlib-compressed zlib creates the smallest disk images, but they only work on Mac OS 10.1
and later.

ADC-compressed ADC images are a bit larger and slower than zlib images, but they work
on Mac OS X 10.0 and later.

NDIF-compressed NDIF images work with Disk Copy 6.x on Mac OS 9, as well as on
Mac OS X. They have resource forks and so must be encoded with a utility such as
Stuftlt, MacBinary, or BinHex before they are shared on the Internet. NDIF images
do not support encryption and they are limited to 2 GB.

3.3.2 Encryption

Encrypted images require a password for access. They only work on Mac OS X 10.1 and
later.

3.3.3 Post-compress with GZip

With this option enabled, DropDMG will compress DMG images so that you end up with a
.dmg. gz file. This compression is in addition to the zlib/ADC compression that is intrinsic
to the image format, so the resulting file will be a bit smaller. Some Web servers have trouble
handling plain .dmg files, so that when people download them they open in the Web browser
instead of Disk Copy. Using .dmg.gz files eliminates this problem, at the expense of an extra
decompression step after downloading (usually using Stufflt Expander or OpenUp).

DropDMG does not GZip NDIF images because GZip compression does not work with
files that have resource forks.

Note that GZip requires that Mac OS X’s optional “BSD Subsystem” package be in-
stalled.

3.3.4 Saving Images

You can choose to have images created in the same folder as the source folder, or specify a
folder where all images should be saved. Note that if you specify a destination folder that’s
contained by the source folder, DropDMG will revert to its default behavior of saving the
image next to the source folder.

3.3.5 Packages

Some Mac OS X files, such as a applications, are actually special folders called packages.
The system presents packages to the user as a single file, but they’re actually stored on disk
as folders. Normally, when DropDMG makes an image from a folder it copies the contents
of the folder into the image; that is, the mounted image behaves just like the original folder
did.



Since packages are folders, you can make images of them with DropDMG. However, if
DropDMG proceeds as usual, when you mount an image that was created from a package,
the Finder will think that the mounted image is a package. It will show the package icon
instead of the disk image icon, but it won’t let you double-click the mounted image to access
the package (e.g. launch the application). You might think that you could drag the mounted
image to your hard disk to launch the application from there, but the Finder will create an
alias instead (unless you know to hold down Option).

Therefore, by default, DropDMG recognizes when you are imaging a package and gives
you a disk image with the package inside it, instead of making an image of the package. To
disable this feature, and thus have DropDMG treat all folders consistently, click the Copy
contents of package radio button.

4 Contact Information

The DropDMG Web site is located at http://www.c-command.com/dropdmg/. Questions
about DropDMG may be sent to mailto:support@c-command.com. I'm always looking to
improve DropDMG, so please feel free to send any feature requests to that address.

To make sure that you have the latest version of DropDMG, you may wish to subscribe
to the DropDMG Announcements mailing list. To sign up, send an e-mail to mailto:
requests@c-command.com with subject subscribe dropdmg-announce. The traffic on this
list is very low, only one message per new version of DropDMG.

5 Registering

DropDMG is shareware. If you find yourself using DropDMG beyond a reasonable trial
period, you must register it. Registration costs $5 (US) and entitles you to free updates and
support.

To register, go to http://store.eSellerate.net/s.asp?s=STR804431608. Soon after
paying, you'll receive an e-mail with your serial number. Enter it in the Registration window
to personalize your copy of DropDMG.

This is the honor system. If you use DropDMG without registering, I probably won't
know. However, registering will give me an incentive to continue updating and enhancing
DropDMG, and to write more Mac software. And you won’t have to look at the “Unregis-
tered” in the status window anymore.

6 Notes and Limitations

e The destination volume must have free space at least equal to twice the size of the
folder, because DropDMG needs space to compress the image.

e Dragging a volume onto DropDMG creates an image that contains the volume’s con-
tents, not an image of the device. Use Disk Copy to create images of devices, e.g. to
make an image of a bootable CD-ROM.
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DropDMG will not copy Desktop DB, Desktop DF, or .Trashes to the top level of
the disk image. These files are managed by the operating system and should not be
replaced. Do not create your own files with these names at the top level of your source
folder.

DropDMG cannot create an image of the startup volume. (You’'ll get a slightly con-
fusing error message.)

Due to a bug in Cocoa, DropDMG may fail when copying extremely large (multiple
GB) files to the disk image.

Future versions of DropDMG may address these issues.

7

Version History

1.3—February 25, 2002

You can now choose whether images are saved next to the source folder, or in a user-
defined folder.

Volume images are now created in ~/Desktop by default (instead of /Volumes).

Resolved problem in which DropDMG tried to replace invisible system files on the
image, if the source folder contained items with the same names.

The format parameter is now optional when creating images with AppleScript.
Notifies the system after fixing an image’s type and creator.

Fixed bug in which DropDMG would report the wrong file as the cause of a copy error.
The keyboard loop in the Preferences window should work again.

The status window no longer flickers when the program first opens.

The distribution is smaller, since the manual uses fewer images.

1.2.1—February 11, 2002

Uses Carbon to preserve Finder info (e.g. the locked, stationery, and custom icon bits)
when copying files.



1.2—February 3, 2002

All options are now available from the scripting interface.

No longer requires Mac OS X’s optional “BSD Subsystem” installation.
Optionally post-compresses DMGs with GZip.

Fixes type and creator codes of DMGs.

Preferences window is easier to use; now, enablement is only tied to the Image Format
radio buttons.

Capitalizations now follow the Aqua Human Interface Guidelines.

1.1—January 28, 2002

Supports ADC and NDIF compression for compatibility with Mac OS 10.0.x and Mac
OS 9, respectively.

Supports encrypted compressed images in the zlib and ADC formats.

Optionally detects packages so that you end up with a mounted image containing the
package instead of a mounted image that the Finder thinks is a package.

Copies locked files to images (instead of stopping with an access error).

Images’ logical sizes are smaller; this should slightly reduce their physical sizes and
reduce mount times.

Accepts drops of all file types (including packages); if DropDMG doesn’t know how to
handle a dropped file it will just ignore it.

The Make Image From Folder... menu command lets you choose packages and subfolders
of packages (instead of just vanilla folders).

Minor UI tweaks.

1.0—January 21, 2002

First public release.



8 Legal Stuff

DropDMG and this manual are copyright (©) 2002 Michael Tsai, mailto:mjt@c-command.
com. All rights reserved.

Please distribute the unmodified DropDMG-1.3.dmg file on the Web, LANs, compilation
CD-ROMs, ete. Please do not charge for it (beyond a reasonable cost for media), or distribute
the contents of the image file in isolation.

This software is provided by the copyright holders and contributors “as is” and any
express or implied warranties, including, but not limited to, the implied warranties of mer-
chantability and fitness for a particular purpose are disclaimed. In no event shall the regents
or contributors be liable for any direct, indirect, incidental, special, exemplary, or consequen-
tial damages (including, but not limited to, procurement of substitute goods or services; loss
of use, data, or profits; or business interruption) however caused and on any theory of lia-
bility, whether in contract, strict liability, or tort (including negligence or otherwise) arising
in any way out of the use of this software, even if advised of the possibility of such damage.

DropDMG is a trademark of Michael Tsai. Mac is a registered trademark of Apple
Computer. All other products mentioned are trademarks of their respective owners.
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